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Avis juridique
Logiciel informatique confidentiel. Licence HP valide requise pour toute 
possession, utilisation ou copie. En accord avec les articles FAR 12.211 et 
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qui sont fournies avec ces produits et services. Aucune partie de ce 
document ne doit être interprétée comme constituant une garantie 
supplémentaire. HP ne peut en aucun cas être tenu pour responsable des 
erreurs techniques ou rédactionnelles contenues dans le présent 
document.

Intel et Itanium sont des marques ou des marques déposées d'Intel 
Corporation ou de ses filiales, aux États-Unis et dans d'autres pays.
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À propos de ce document
1

À propos de ce document
Ce document sert de référence et fournit également des informations sur 
des rubriques qui sont rarement nécessaires lors de l'utilisation courante 
et quotidienne de HP Integrity Essentials Global Workload Manager 
pour les serveurs HP Integrity et HP 9000 (gWLM).

Utilisateurs potentiels

Ce document est destiné aux administrateurs de système VSE (Virtual 
Server Environment), aux administrateurs d'applications VSE et autres 
professionnels de l'informatique impliqués dans l'exploitation, 
l'administration et la planification de centres de données. On suppose 
une connaissance des concepts et des procédures d'administration 
système HP-UX.

Informations connexes

Les documents suivants sont disponibles à partir du site Web 
http://docs.hp.com :

• HP Integrity Essentials Global Workload Manager - Guide de mise en 
route

• Guide d'installation et de mise à jour du logiciel de gestion VSE

• Logiciel de gestion VSE - Guide de mise en route

• HP Integrity Essentials Capacity Advisor - Guide de mise en route

• HP Integrity Virtual Machines Manager - Guide de mise en route

• HP Integrity Virtual Machines Manager - Notes de publication

• HP Integrity Virtual Machines - Installation, configuration et 
administration
Chapitre 1 7



À propos de ce document
Commentaires et suggestions

Vos commentaires et suggestions concernant les fonctionnalités de 
produits nous aideront à développer les versions ultérieures du logiciel 
de gestion Virtual Server Environment.

Utilisez l'adresse de messagerie suivante pour faire part de vos 
commentaires directement à l'équipe de développement de gWLM : 
gwlmfeedback@rsn.hp.com.

Pour nous faire part de vos commentaires sur un logiciel de gestion VSE 
autre que gWLM, utilisez l'adresse de messagerie suivante pour 
contacter directement l'équipe de développement du logiciel de gestion 
VSE : vse@hpuxweb.fc.hp.com.

REMARQUE HP n'est pas en mesure de fournir un support produit par le biais de ces 
adresses de messagerie. Pour obtenir de l'assistance concernant un 
produit, contactez votre représentant de support technique HP, votre 
représentant clientèle HP ou votre revendeur HP agréé. Pour plus 
d'informations sur les services de support technique, reportez-vous au 
site Web http://www.hp.com/go/support. (Si vous souhaitez obtenir une 
assistance dans un autre pays, reportez-vous au site 
http://welcome.hp.com/country/us/en/othercountrieswel.html. Cliquez 
sur le lien correspondant à votre pays ou région, puis cliquez sur 
"Support & Dépannage".

Pour accéder à un forum d'utilisateurs de gWLM, reportez-vous au forum 
du Centre de ressources informatiques d'HP-UX Workload/Resource 
Management :

http://forums.itrc.hp.com/cm/CategoryHome/1,,213,00.html

Pour d'autres moyens de contacter HP, reportez-vous au site 
http://welcome.hp.com/country/fr/fr/contact_us.html. (Si vous souhaitez 
contacter HP dans un autre pays, reportez-vous au site 
http://welcome.hp.com/country/us/en/othercountrieswel.html.) Cliquez 
sur le lien correspondant à votre pays ou région, puis cliquez sur 
"Contacter HP".
Chapitre 18



Qu'est-ce que gWLM ?
Qu'est-ce que gWLM ?
gWLM vous permet de définir de manière centralisée des stratégies de 
partage de ressources utilisables sur plusieurs serveurs HP. Ces 
stratégies optimisent l'utilisation du système et facilitent le partage 
contrôlé des ressources système. En outre, gWLM fournit un contrôle 
historique et en temps réel de l'allocation des ressources. 
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Les interfaces disponibles
Les interfaces disponibles
Il existe deux interfaces pour contrôler le fonctionnement de gWLM :

• HP Systems Insight Manager (démarrée par la commande 
/opt/mx/bin/mxstart)

Une interface basée sur le Web à laquelle vous pouvez accéder par le 
biais de l'onglet Shared Resource Domain, accessible via le menu 
Tools -> VSE Management dans HP Systems Insight Manager 
(pour accéder à HP Systems Insight Manager, utilisez l'URL 
http://nom_hôte:280 où nom_hôte représente le nom de votre CMS 
logiciel de gestion VSE).

Pour vous orienter dans gWLM, reportez-vous à la page d'accueil 
gWLM dans cette interface en sélectionnant dans la barre de menus 
SIM :

Tools
-> VSE Management

et cliquez sur l'onglet Shared Resource Domain puis, dans la barre de 
menus VSE Management :

Tools
-> Global Workload Manager
-> Getting Started - gWLM Home…

(Les barres de menus SIM et VSE Management sont discutées dans 
la section suivante intitulée "Onglets et menus".)

• Commande gwlm

Une interface de ligne de commande, décrite dans la page de manuel 
gwlm(1M).

Les autres composants de l'interface de ligne de commande sont les 
suivants : vseinitconfig(1M), gwlmcmsd(1M), gwlmagent(1M), 
gwlmreport(1M), gwlmplace(1M), gwlmsend(1M), gwlmsslconfig(1M) 
et gwlmxml(4).
Chapitre 110



Réservation d'un espace dédié aux données historiques
Onglets et menus

Les contrôles illustrés ci-dessous apparaissent en haut de l'écran Global 
Workload Manager.

Figure 1-1 Contrôles supérieurs de l'écran Global Workload Manager

Réservation d'un espace dédié aux données 
historiques
HP vous recommande d'allouer 4 Go de stockage pour chaque centaine 
de charges de travail que vous gérerez avec gWLM. Avec un intervalle 
d'échantillonnage de 5 minutes, cela suffira pour stocker deux années de 
données, que vous pourrez utiliser à des fins de planification de capacité 
et de gestion des performances.

Réservez cet espace dans /var/opt/.

➊

➊

➌

➋

➌

➋

La barre de menus SIM

Les onglets Virtualization Manager

La barre de menus VSE Management
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Sauvegarde de la base de données gWLM
Sauvegarde de la base de données gWLM
La base de données gWLM contient des données de configuration ainsi 
que des données de performances historiques. Utilisez la commande 
vseinitconfig --backup pour créer une sauvegarde de votre base de 
données gWLM. Pour utiliser le fichier de sauvegarde, utilisez la 
commande vseinitconfig --restore. 

Pour plus d'informations, reportez-vous à la page de manuel 
vseinitconfig(1M).

Conseils relatifs à la sauvegarde et à la restauration

Voici quelques conseils pour tirer le meilleur parti des processus de 
sauvegarde et de restauration :

• Pour vous assurer que les données gWLM les plus récentes sont 
sauvegardées, exécutez la commande suivante avant d'utiliser 
l'option --backup :

gwlm history --flush

• Si possible, dédéployez tous les domaines SRD avant d'effectuer une 
sauvegarde ; ou bien, après avoir effectué une restauration, 
dédéployez tous les domaines SRD et redéployez-les.

• Si le CMS ou les nœuds gérés ont été modifiés (par exemple si vous 
avez changé des quantités de processeurs ou des noms d'hôtes) entre 
une sauvegarde et une restauration, gWLM ne fonctionnera 
probablement pas comme prévu après la restauration.
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Compatibilité avec les agents / OpenVMS / Linux
Compatibilité avec les agents / OpenVMS / 
Linux
Le CMS gWLM A.02.50.00.x s'exécute sur HP-UX 11i v1 (B.11.11) et 
HP-UX 11i v2 (B.11.23). Il fonctionne avec les versions suivantes des 
agents :

• gWLM A.01.01.02 : HP-UX 11i v1, HP-UX 11i v2, Linux

• gWLM A.01.01.03 / A.01.01.04 : OpenVMS Version 7.3-2 et 
ultérieures pour les serveurs Alpha, OpenVMS 8.2-1 et versions 
ultérieures pour les serveurs HP Integrity

• gWLM A.02.00.00.x : HP-UX 11i v1, HP-UX 11i v2

• gWLM A.02.50.00.x : HP-UX 11i v1, HP-UX 11i v2, HP-UX 11i v3, 
Linux, OpenVMS Version 7.3-2 et ultérieures pour serveurs Alpha, 
OpenVMS 8.2-1 et versions ultérieures pour serveurs HP Integrity

REMARQUE Les agents sur HP-UX 11i v3 ne prennent pas en charge l'activation de 
l'hyperthreading ni les opérations de cellule en ligne.

L'utilisation du CMS gWLM A.02.50.00.x ne vous permet pas d'utiliser la 
fonctionnalité A.02.50.00.x avec des agents plus anciens : les 
combinaisons de types et les types de compartiments potentiels 
disponibles à l'origine avec les agents plus anciens sont toujours 
appliqués. En outre, les partitions imbriquées sont en général 
disponibles uniquement avec A.02.50.00.x et versions ultérieures.

De plus, tous les agents gWLM d'un domaine SRD doivent avoir le même 
numéro de révision : un CMS gWLM A.02.50.00.x peut gérer un domaine 
SRD qui utilise uniquement des agents A.02.50.00.x, uniquement des 
agents A.02.00.00.x, uniquement des agents A.01.01.04, uniquement des 
agents A.01.01.03 ou uniquement des agents A.01.01.02.
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Sécurisation des communications gWLM
Sécurisation des communications gWLM
Par défaut, les communications gWLM ne sont pas sécurisées, ce qui 
signifie que :

• Les communications ente le CMS et les nœuds gérés ne sont pas 
chiffrées

• La source et la destination des communications gWLM ne sont pas 
authentifiées

Pour sécuriser les communications gWLM, suivez les étapes décrites 
dans la page de manuel gwlmsslconfig(1M).

REMARQUE HP recommande vivement de toujours utiliser gWLM avec des 
communications sécurisées.
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Définition des propriétés de gWLM
Définition des propriétés de gWLM
gWLM propose deux fichiers de propriétés qui vous permettent de 
contrôler divers comportements de gWLM. L'un des fichiers concerne le 
démon CMS, tandis que l'autre concerne tous les nœuds gérés. Consultez 
ces fichiers pour plus d'informations sur les comportements qu'ils 
contrôlent.

Propriétés CMS 
(/etc/opt/gwlm/conf/gwlmcms.properties)

REMARQUE Certaines valeurs sont lues par gWLM uniquement lorsqu'un démon est 
installé, alors que d'autres sont lues lorsqu'un domaine SRD est déployé. 
Consultez le fichier pour plus d'informations sur la lecture de chaque 
propriété. 

Le redémarrage de gwlmcmsd désactive temporairement 
HP Integrity Essentials Virtualization Manager et 
HP Integrity Essentials Capacity Advisor.

Le fichier gwlmcms.properties se présente comme suit.

#(C) Copyright 2004 -2006 Hewlett-Packard Development Company, L.P.
#
# $Date: 2006/05/19 17:52:24 $
# $Revision: 1.18 $
#
# Contents:
#       This file contains the default configuration values for the
#       Global Workload Manager CMS.
#
#       You must restart gwlmcmsd for changes made to this file
#       to take effect--unless otherwise noted.
#

#
# Set FileHandler /var/opt/gwlm/gwlmcmsd.log.0 log level.
# Valid levels, from most severe to least, are:
#       SEVERE
#       WARNING
#       INFO
#       CONFIG
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Définition des propriétés de gWLM
#       FINE
#       FINER
#       FINEST
# When you set the level, you will see messages only from that level and
# the levels that are more severe. So, the SEVERE level produces the fewest
# messages, while the FINEST level includes messages from all seven levels.
#
com.hp.gwlm.util.Log.logLevel = INFO

#
# Turn on/off ConsoleHandler. ConsoleHandler uses the same log
# level as defined for FileHandler /var/opt/gwlm/gwlmcmsd.log.0.
#
com.hp.gwlm.util.Log.ConsoleHandler = off

#
# Support for the database cache on the CMS.
#
#   cachesize:
#       The number of database objects that should be cached in memory
#       in order to reduce the number of round-trip operations.
#
com.hp.gwlm.cms.cachesize = 70000

# Support for local data caching on a remote node for report generation.
# These properties are defined on the CMS but are pushed out to the remote
# node managers during deployment of an SRD.  The cached objects on the
# agent consume an amount of memory approximated by:
#
#    Memory = 5000 * workloads * cachesize * (60 / resource_domain_interval)
#
# bytes of memory.  For example, if there are 4 workloads deployed with a
# 15 second interval and a cachesize of 20 minutes, the agent will need:
#
#    Memory = 5000 * 4 * 20 * (60 / 15) ~ 2.5 MB.

#
#   cachesize:
#       The number of minutes of real-time data to maintain on the remote
#       node for future CMS access.  This value must be at least three
#       times the ‘samples’ value specified below.  The default value is
#       20 minutes.
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Définition des propriétés de gWLM
#
#   samples:
#       The number of minutes of real-time data used to aggregate into a
#       historical data point. The default is to aggregate the data into
#       5-minute averages.
#
com.hp.gwlm.node.cachesize = 20
com.hp.gwlm.node.samples   = 5

#
# Support for real-time graphing properties.
#
#   viewport:
#       The size of the displayed real-time graph (in minutes).
#
#   refresh:
#       The refresh rate of the real-time graphs and tables (in seconds).
#
com.hp.gwlm.ui.monitor.viewport = 15
com.hp.gwlm.ui.monitor.refresh  = 15

Propriétés des agents 
(/etc/opt/gwlm/conf/gwlmagent.properties)

REMARQUE Vous devez redémarrer le démon gwlmagent sur chaque nœud géré sur 
lequel vous avez modifié le fichier de propriétés pour que les 
modifications apportées au fichier prennent effet.

Le fichier gwlmagent.properties se présente comme suit.

#
#(C) Copyright 2004 -2006 Hewlett-Packard Development Company, L.P.
#
# $Date: 2006/05/19 17:52:23 $
# $Revision: 1.13 $
#
# Contents:
#       This file contains the default configuration values for the
#       Global Workload Manager Agent on a given managed node. Les
#       agent on each managed node uses the default values unless you
#       edit that node’s gwlmagent.properties file.
#
#       You must restart gwlmagent for changes made to this file to
#       take effect.
#
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Définition des propriétés de gWLM
#
# Set FileHandler /var/opt/gwlm/gwlmagent.log.0 log level.
# Valid levels, from most severe to least, are:
#       SEVERE
#       WARNING
#       INFO
#       CONFIG
#       FINE
#       FINER
#       FINEST
# When you set the level, you will see messages only from that level and
# the levels that are more severe. So, the SEVERE level produces the fewest
# messages, while the FINEST level includes messages from all seven levels.
#
com.hp.gwlm.util.Log.logLevel = INFO

# Specify the size (in MB) and number of files to use  
# for logging. For a single file of unlimited size, set
# logFileSize to negative one (logFileSize=-1).
# Otherwise, total log file size is
#    logFileSize * logNFiles
#
com.hp.gwlm.util.Log.logFileSize = 20
com.hp.gwlm.util.Log.logNFiles = 3

#
# Turn on/off ConsoleHandler. ConsoleHandler uses the same log
# level as defined for FileHandler /var/opt/gwlm/gwlmagent.log.0.
#
com.hp.gwlm.util.Log.ConsoleHandler = off

#
# Set the number of seconds for the high availability (HA) minimum
# timeout. Communication is considered lost on a managed node
# once the timeout period has elapsed.
#
# By default, communication is not considered lost until 10 allocation
# intervals have elapsed without communication. The default value of the
# property (60) is used only when the allocation interval is less than 6
# seconds.  
#
com.hp.gwlm.node.HA.minimumTimeout = 60
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Définition des propriétés de gWLM
#
# Enable/disable use of Instant Capacity (iCAP) to simulate CPU movement
# across nPartitions. To use iCAP, you must enable this property on each
# managed nPartition where you want to take advantage of iCAP. Also, each
# nPartition must meet the requirements outlined in the online help topic
# “Getting the most out of gWLM” as well as in the section “USING NPARS AS
# COMPARTMENTS IN AN SRD” in the gwlmxml(4) man page on HP-UX or the
# gwlmxml(5) man page on Linux.
#
com.hp.gwlm.platform.icap.manageWithIcap = on

Ports de communication

gWLM utilise les ports de communication suivants :

Nœuds gérés : 9617

CMS : 9618

Si vous devez modifier ces ports, ajoutez les lignes suivantes :

com.hp.gwlm.cms.port = portX

com.hp.gwlm.node.port = portY

aux deux fichiers de propriétés :

/etc/opt/gwlm/conf/gwlmcms.properties

/etc/opt/gwlm/conf/gwlmagent.properties

Les valeurs portX et portY ne peuvent pas être identiques.

La propriété com.hp.gwlm.cms.port doit avoir la même valeur portX 
dans tous les fichiers de propriétés, dans tous les nœuds gérés et sur le 
CMS. De même, la propriété com.hp.gwlm.node.port doit avoir la même 
valeur portY dans tous les fichiers de propriétés, dans tous les nœuds 
gérés et sur le CMS.

Vous devez redémarrer gwlmcmsd et gwlmagent pour que les 
modifications prennent effet. Si vous utilisez gWLM par le biais 
d'HP Systems Insight Manager (SIM), vous devez également arrêter 
(/opt/mx/bin/mxstop) et redémarrer (mxstart) SIM.

REMARQUE Le redémarrage de gwlmcmsd désactive temporairement 
HP Integrity Essentials Virtualization Manager et 
HP Integrity Essentials Capacity Advisor.
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Contrôle du comportement de démarrage de gWLM
Contrôle du comportement de démarrage de 
gWLM
Le démon CMS gWLM (gwlmcmsd) est configuré pour démarrer à 
l'amorçage par /opt/vse/bin/vseinitconfig. En général, vous ne devez pas 
modifier ce paramètre car il empêche tous les logiciels de gestion VSE de 
démarrer à l'amorçage.

Vous pouvez contrôler si le démon CMS gWLM (gwlmcmsd) et ses démons 
d'agents sur les nœuds gérés (gwlmagent) démarrent à l'amorçage en :

• Définissant manuellement des variables dans le fichier 
/etc/rc.config.d/gwlmCtl . (Les scripts /sbin/init.d/gwlmcmsd et 
/sbin/init.d/gwlmagt utilisent ces variables.)

• Utilisant les options --enable_start_on_boot et 
--disable_start_on_boot de gwlmcmsd et gwlmagent.

REMARQUE HP recommande de démarrer ces démons à l'amorçage uniquement en 
cas d'utilisation dans un environnement d'exploitation sécurisé.

L'affectation de la valeur 0 à GWLM_CMS_START empêche l'utilisation 
automatique d'HP Integrity Essentials Virtualization Manager et 
HP Integrity Essentials Capacity Advisor à l'amorçage.

Le fichier gwlmCtl se présente comme suit :

########################################################################
# (C) Copyright 2004 Hewlett-Packard Development Company, L.P.
#
# gWLM Configuration File
#
# $Revision: 1.6 $
# $Date: 2006/01/10 17:07:07 $
########################################################################

# Set GWLM_CMS_START to 1 to have the init process start the gWLM CMS
# daemon. (HP recommends setting this variable to 1 only when used in a
# secure operating environment.)
#
# NOTE: GWLM_CMS_START=0 prevents automatic use at boot of 
#       HP Integrity Essentials Virtualization Manager and 
#       HP Integrity Essentials Capacity Advisor.
GWLM_CMS_START=0
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# Set GWLM_AGENT_START to 1 to have the init process start the gWLM agent
# daemon. (HP recommends setting this variable to 1 only when used in a
# secure operating environment.)
GWLM_AGENT_START=0

# Set GWLM_HOME to the location where gWLM is installed.
# Default is /opt/gwlm.
GWLM_HOME=/opt/gwlm
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Redémarrage automatique des nœuds gérés 
de gWLM dans des domaines SRD 
(Disponibilité élevée)
Chaque fois qu'un nœud géré est amorcé, son agent gWLM tente de 
rejoindre automatiquement le nœud dans son domaine SRD, afin de 
fournir une disponibilité élevée. Les seules étapes de configuration à 
effectuer pour que ce comportement se produise sont les suivantes :

Étape 1. Assurez-vous que le fichier /etc/rc.config.d/gwlmCtl sur chaque nœud 
géré a un paramètre GWLM_AGENT_START défini à 1. Vous pouvez exécuter 
la commande suivante sur chaque système sur lequel gwlmagent est en 
cours d'exécution pour qu'il apporte la modification pour vous :

# /opt/gwlm/bin/gwlmagent --enable_start_on_boot 

Dans le même fichier, il vous faut également GWLM_CMS_START=1 sur le 
système sur lequel gwlmcmsd est en cours d'exécution. Toutefois, lorsque 
vous avez exécuté /opt/vse/bin/vseinitconfig durant l'installation, cette 
modification a été apportée automatiquement.

Étape 2. (Facultatif) Modifiez la propriété

com.hp.gwlm.node.HA.minimumTimeout

dans le fichier /etc/opt/gwlm/conf/gwlmagent.properties afin de définir le 
nombre minimum de secondes qui doivent s'écouler avant qu'un nœud 
géré se considère comme séparé de son domaine SRD. Définissez cette 
propriété afin de vous assurer que des problèmes réseau mineurs ne font 
pas en sorte qu'un nœud géré ne se considère pas prématurément comme 
séparé.

gWLM utilise cette valeur uniquement si elle est supérieure à 10 
multiplié par l'intervalle d'allocation de gWLM. Par exemple, avec un 
intervalle d'allocation de 15 secondes, un nœud peut passer 2,5 minutes 
sans communiquer avec son domaine SRD avant que son agent gWLM ne 
tente de rétablir une connexion avec le domaine SRD.

Cette fonctionnalité est plus performante lorsqu'un nœud géré est perdu 
à la fois ou lorsque tous les nœuds gérés sont perdus.
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REMARQUE Si une vpar emprunte des processeurs à d'autres vpars lorsqu'elle perd 
contact avec son domaine SRD, ces processeurs empruntés peuvent être 
séparés du domaine SRD. Si la vpar peut être désactivée pendant une 
durée prolongée, vérifiez que le domaine SRD s'est reformé sans cette 
vpar et qu'il dispose de suffisamment de processeurs pour remplir ses 
engagements. Si ce n'est pas le cas, essayez d'utiliser vparmodify pour 
récupérer une partie des processeurs. (Avec la vpar désactivée, vous ne 
pourrez pas la modifier localement, et seules certaines versions de 
HP-UV Virtual Partitions vous permettent de modifier une vpar 
distante.)

De même, si une npar a plusieurs processeurs actifs (à cause d'Instant 
Capacity) lorsqu'elle perd contact avec son domaine SRD, vous devrez 
peut-être dimensionner manuellement la npar de façon à récupérer ces 
processeurs pour les npars qui se trouvent encore dans le domaine SRD. 
Pour plus d'informations sur ces aspects, reportez-vous à la 
documentation d'Instant Capacity.

Fonctionnement du redémarrage automatique

Lorsqu'un nœud géré est amorcé, l'agent gWLM (gwlmagent) démarre 
automatiquement si GWLM_AGENT_START a la valeur 1 dans le fichier 
/etc/rc.config.d/gwlmCtl. L'agent vérifie alors le fichier 
/etc/opt/gwlm/deployed.config pour déterminer son CMS. Ensuite, il tente 
de contacter le CMS pour faire en sorte qu'il redéploie sa vue du domaine 
SRD. Si le CMS ne peut être contacté, le domaine SRD dans le fichier 
deployed.config est déployé, à condition que tous les nœuds soient 
d'accord.

En général, lorsqu'un domaine SRD est perturbé par la panne d'un nœud 
ou par des problèmes de communication réseau, gWLM tente de reformer 
le domaine SRD. gWLM maintient le concept d'un cluster pour les nœuds 
d'un domaine SRD. Dans un cluster, un nœud est un maître et les autres 
nœuds sont des non-maîtres. Si le nœud maître perd contact avec le reste 
du domaine SRD, le reste du domaine SRD peut continuer sans lui, en 
tant que cluster partiel, en nommant de manière unanime un nouveau 
maître. Si un non-maître perd la communication avec le reste du 
domaine SRD, le cluster partiel résultant continue de fonctionner sans le 
nœud perdu. Le maître omet simplement le nœud manquant jusqu'à ce 
qu'il soit de nouveau disponible.
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REMARQUE Les tentatives de reformer des domaines SRD peuvent dépasser le délai 
d'attente, entraînant ainsi l'absence de domaine SRD déployé et par 
conséquent l'absence de gestion des allocations de ressources. Si cela se 
produit, arrêtez et démarrez les agents, comme décrit dans la section 
Événement "Node Failed to Rejoin SRD on Start-up" ci-dessous.

Événements connexes

Vous pouvez configurer les événements SIM suivants concernant cette 
fonctionnalité de redémarrage automatique :

• Node Failed to Rejoin SRD on Start-up

• SRD Reformed with Partial Set of Nodes

• SRD Communication Issue

Pour plus d'informations sur l'activation et l'affichage de ces événements, 
reportez-vous au menu "Configure Events" de gWLM.

Vous pouvez afficher ces événements à l'aide de l'élément Event Lists 
situé dans le volet gauche de SIM.

Les sections suivantes expliquent comment gérer certains des 
événements.

Événement "Node Failed to Rejoin SRD on Start-up"

Si vous constatez la présence de cet événement : 

Étape 1. Arrêtez le gwlmagent sur chaque nœud géré dans le domaine SRD 
affecté :

# /opt/gwlm/bin/gwlmagent --stop

Étape 2. Redémarrez l'agent sur chacun de ces nœuds gérés :

# /opt/gwlm/bin/gwlmagent

Étape 3. Vérifiez que l'agent a rejoint le domaine SRD en contrôlant la vue Shared 
Resource Domain dans SIM ou en exécutant la commande gwlm 
monitor.

Étape 4. Si le problème persiste, vérifiez si les fichiers 
/var/opt/gwlm/gwlmagent.log.0 et /var/opt/gwlm/gwlm/gwlmcmsd.log.0 
contiennent des messages de diagnostic supplémentaires.
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Événements "SRD Communication Issue" / "SRD Reformed with 
Partial Set of Nodes"

REMARQUE La reformation avec un ensemble de nœuds partiel requiert un minimum 
de trois nœuds gérés dans le domaine SRD.

REMARQUE Les événements "SRD Communication Issue" ne sont pas activés par 
défaut. Pour afficher ces événements, configurez vos événements dans 
SIM par le biais de la barre de menus VSE Management à l'aide de Tools 
-> Global Workload Manager -> Events.

Si vous avez un domaine SRD contenant n nœuds et que vous recevez des 
événements

n - 1 événements "SRD Communication Issue"

mais aucun

événement "SRD Reformed with Partial Set of Nodes" dans les 5 minutes 
qui suivent (en supposant que l'intervalle d'allocation soit de 
15 secondes) le premier événement "SRD Communication Issue"

vous devrez peut-être :

Étape 1. Arrêter le gwlmagent sur chaque nœud géré dans le domaine SRD 
affecté :

# /opt/gwlm/bin/gwlmagent --stop

Étape 2. Redémarrer l'agent sur chacun de ces nœuds gérés :

# /opt/gwlm/bin/gwlmagent

Effacement manuel d'un domaine SRD

Si gWLM est incapable de reformer un domaine SRD, vous pouvez 
effacer manuellement le domaine SRD comme décrit ci-dessous. 

Effacement d'un domaine SRD d'un agent A.02.50.00.x (ou 
version ultérieure)

La commande discutée ci-dessous est une commande avancée pour 
l'effacement d'un domaine SRD. La méthode recommandée pour 
supprimer un hôte du système de gestion consiste à utiliser la commande 
gwlm undeploy.
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À compter des agents A.02.50.00.x, vous pouvez effacer manuellement 
un domaine SRD à l'aide de la commande suivante :

# gwlm reset --host=hôte

où hôte spécifie l'hôte contenant le domaine SRD à effacer. 

Si la commande ci-dessus ne fonctionne pas, appliquez la procédure 
décrite dans la section suivante.

Effacement d'un agent SRD d'une version quelconque

La procédure suivante permet d'effacer un domaine SRD quelle que soit 
la version des agents dans le domaine SRD :

Étape 1. Supprimez le fichier deployed.config sur chaque nœud géré :

# rm -f /etc/opt/gwlm/deployed.config

Étape 2. Forcez un dédéploiement du domaine SRD (nommé SRD ci-dessous) afin 
de vous assurer que le CMS et les nœuds gérés s'accordent sur l'état du 
domaine SRD. Exécutez la commande suivante sur le CMS :

# /opt/gwlm/bin/gwlm undeploy --srd=SRD --force

Étape 3. Arrêtez le démon gwlmagent sur chaque nœud géré :

# /opt/gwlm/bin/gwlmagent --stop

Étape 4. Démarrez le démon gwlmagent sur chaque nœud géré :

# /opt/gwlm/bin/gwlmagent

REMARQUE Si le CMS gWLM et l'agent ne sont pas d'accord sur le fait qu'un domaine 
SRD soit déployé ou dédéployé, vous pouvez utiliser l'option --force 
avec la commande gwlm deploy ou gwlm undeploy.
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Partitions imbriquées
gWLM vous permet de former des domaines SRD constitués de différents 
types de compartiments. Cette capacité procure une flexibilité dans la 
division de votre complexe. Par exemple, vous pouvez diviser votre 
complexe comme illustré à la figure 1-2. Le complexe possède quatre 
npars, dont deux sont divisées en vpars. Une npar héberge des machines 
virtuelles et la quatrième npar n'est pas divisée. gWLM vous permet de 
créer un domaine SRD contenant les deux machines virtuelles invitées, 
les deux vpars de la npar 2, les deux vpars de la npar 3 et la npar 4. Les 
charges de travail de ces compartiments peuvent alors emprunter des 
ressources à tous les autres compartiments du domaine SRD. Si 
Temporary Instant Capacity est disponible sur le complexe, gWLM peut 
migrer les droits d'exploitation là où ils sont nécessaires.

Figure 1-2 Partitions imbriquées

Pour plus d'informations sur les partitions imbriquées, reportez-vous à 
l'aide en ligne ou à la page de manuel gwlm(1M) sur HP-UX.
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Modification de l'intervalle d'allocation de 
gWLM
La fréquence de changement des allocations de processeurs par gWLM 
est un attribut des domaines SRD. Une fois que vous avez créé un 
domaine SRD, vous pouvez modifier la fréquence à laquelle gWLM ajuste 
les allocations de processeurs des charges de travail dans ce domaine 
SRD en appliquant l'une des méthodes décrites dans les sections 
suivantes.

Modification de l'intervalle dans HP Systems Insight 
Manager

REMARQUE Si vous gérez des machines virtuelles, spécifiez un intervalle d'allocation 
de ressources qui est un multiple de l'intervalle vm_fssagt, dont la 
valeur par défaut est 10 secondes. Si vous avez besoin d'un intervalle 
d'allocation de ressources inférieur à 10 secondes, définissez l'intervalle 
des agents VM (à l'aide de vm_fssagt -i) à la même valeur que votre 
intervalle d'allocation de ressources. 

Avec SIM, vous pouvez définir l'intervalle à deux endroits :

• Lors de la création d'un domaine SRD :

Sélectionnez dans la barre de menus SIM :

Tools
-> VSE Management

et cliquez sur l'onglet Shared Resource Domain puis, dans la barre de 
menus VSE Management :

Create
-> Shared Resource Domain

• Lors de la modification d'un domaine SRD :

Sélectionnez dans la barre de menus SIM :

Tools
-> VSE Management
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et cliquez sur l'onglet Shared Resource Domain puis, dans la barre de 
menus VSE Management :

Modify
-> Shared Resource Domain

Modification de l'intervalle à partir de la ligne de 
commande

Utilisez la commande gwlm et un éditeur de texte pour modifier 
l'intervalle à partir de la ligne de commande :

Étape 1. Utilisez gwlm export pour obtenir une copie de la définition XML du 
domaine SRD à partir du référentiel de configuration gWLM.

Étape 2. Modifiez l'attribut "interval", dont l'unité est la seconde.

REMARQUE Si vous gérez des machines virtuelles, définissez la valeur d'attribut de 
l'intervalle à un multiple de l'intervalle vm_fssagt, dont la valeur par 
défaut est 10 secondes. Si vous avez besoin d'une valeur d'attribut 
d'intervalle gWLM inférieure à 10 secondes, définissez l'intervalle des 
agents VM (à l'aide de vm_fssagt -i) à la même valeur.

Étape 3. Utilisez gwlm import --clobber pour placer la définition mise à jour 
dans le référentiel de configuration gWLM.

Si un domaine SRD du même nom est déjà déployé, l'opération 
d'importation applique le nouvel intervalle. Autrement, l'intervalle est 
utilisé la prochaine fois que vous déployez le domaine SRD que vous 
venez de définir et d'importer.
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Affichage d'événements HP Systems Insight 
Manager
gWLM vous permet de configurer plusieurs événements et de les 
contrôler par le biais de SIM. Pour afficher ces événements dans SIM, 
procédez comme suit :

Étape 1. Sélectionnez dans la barre de menus SIM :

Tools
-> VSE Management

Étape 2. Sélectionnez l'onglet Shared Resource Domain

Étape 3. Sélectionnez dans la barre de menus VSE Management :

Tools
-> Global Workload Manager
-> Events…

Après avoir configuré ces événements, vous pouvez les contrôler par le 
biais des différents éléments Events dans le volet gauche de SIM.

Affichage de rapports gWLM en mode contrôle 
uniquement
gWLM vous permet de spécifier les utilisateurs qui doivent être 
autorisés uniquement à contrôler les rapports gWLM. Ces utilisateurs 
n'ont pas la possibilité de modifier des configurations gWLM. Pour 
configurer un utilisateur avec des privilèges "contrôle uniquement", 
reportez-vous à la rubrique d'aide en ligne "Authorizations / Read-only 
Monitoring.”
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Contrôle de gWLM à partir de la ligne de 
commande
Il existe plusieurs outils de ligne de commande, accessibles uniquement 
à l'utilisateur root, pour le contrôle de gWLM :

• /opt/gwlm/bin/gwlm monitor

La commande gwlm possède une sous-commande monitor qui affiche 
des statistiques concernant les stratégies, les charges de travail et les 
domaines SRD.

• /opt/gwlm/bin/gwlmreport

Cette commande fournit différents types de rapports : 
topborrowers, resourceaudit, abnormalutil et extract (qui 
fournit des données sous forme de valeurs séparées par des virgules, 
pour une utilisation dans d'autres outils). Elle propose également 
une option ovpafeed qui extrait des données en vue d'une utilisation 
avec OpenView Performance Agent par le biais de l'intégration de 
source de données (DSI, Data Source Integration). En outre, elle peut 
générer un rapport config indiquant l'historique des modifications 
de configuration. 

Pour plus d'informations, reportez-vous aux pages de manuel gwlm(1M) 
et gwlmreport(1M) sur HP-UX. 
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Quelles sont les informations d'état fournies 
par gWLM ?
Pour les messages qui concernent les opérations en cours de gWLM, 
celui-ci enregistre les messages d'erreur et d'informations, ainsi que des 
statistiques, dans l'un des fichiers suivants :

/var/opt/gwlm/gwlmcmsd.log.0

/var/opt/gwlm/gwlmagent.log.0

/var/opt/gwlm/initconfig.log.0

Le nom du journal actuel se termine toujours par .log.0. Dès que ce 
fichier a atteint une certaine taille, un nom de fichier se terminant par 
.log.1 lui est attribué et un nouveau fichier .log.0 est créé. S'il existe déjà 
un fichier .log.1, il est renommé log.2. S'il existe déjà un fichier .log.2, il 
est remplacé ou déplacé vers un autre fichier (jusqu'à un nombre 
maximal de fichiers configurables que vous définissez dans 
/etc/opt/gwlm/conf/gwlmcms.properties).
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Comment gWLM affecte-t-il les ressources de 
processeurs ?
gWLM affecte des niveaux de priorité, du plus élevé au plus faible, et 
alloue les ressources à toutes les demandes d'un niveau de priorité donné 
avant de considérer les demandes de priorité plus faible. Si, à un certain 
niveau de priorité, toutes les demandes ne peuvent pas être satisfaites, 
les ressources restantes sont distribuées de sorte que l'allocation de res-
sources totale pour chaque charge de travail soit le plus proche possible 
de la proportion de son poids relativement à la somme de tous les poids.

Si gWLM a satisfait toutes les demandes de ressources à toutes les 
priorités et qu'il reste des ressources à allouer, il distribue les ressources 
restantes par poids. Là encore, l'objectif est que l'allocation de ressources 
totale pour chaque charge de travail soit le plus proche possible de la 
proportion de son poids relativement à la somme de tous les poids.

Le tableau 1-1 répertorie les poids par défaut pour les différents types de 
stratégies. Pour les stratégies avec des poids, vous pouvez également 
définir le poids de manière explicite. 

REMARQUE Pour garantir que les allocations de processeurs se comportent comme 
prévu pour les stratégies OwnBorrow, la somme des ressources de pro-
cesseur détenues ne peut dépasser le nombre de processeurs dans le 
domaine SRD. (Toutefois, si la somme est inférieure au nombre de pro-
cesseurs dans le domaine SRD, l'excès est distribué à tous les comparti-
ments proportionnellement aux montants détenus. Ainsi, les charges de 
travail obtiendront régulièrement plus que ce auquel elles ont droit.)

Tableau 1-1 Poids par défaut par type de stratégie

Type de stratégie Poids par défaut

Fixed N/A 
(Vous ne pouvez pas déployer un domaine SRD dans lequel 
toutes les charges de travail avec des stratégies fixes ne sont 
pas satisfaites.)

Utilization 1

OwnBorrow Égal à ses ressources de processeur détenues

Custom 1
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Informations complémentaires
Le tableau suivant indique où vous pouvez trouver des informations 
complémentaires.

Tableau 1-2 Où trouver des informations complémentaires

Pour... Reportez-vous à...

Afficher la structure (npars, vpars, 
...) de vos systèmes

Page VSE Management dans 
HP Systems Insight Manager 
(Tools -> VSE Management)

En savoir plus sur la configuration, 
la sauvegarde et la maintenance de 
votre CMS

Page de manuel vseinitconfig(1M)

Utiliser gWLM immédiatement, en 
lisant le moins de documentation 
possible

Page d'accueil gWLM dans SIM
(Tools -> VSE Management, puis sélectionnez 
l'onglet Shared Resource Domain, puis 
Tools -> Global Workload Manager -> Getting 
Started - gWLM Home)

ou

Rubrique Global Workload Manager dans l'aide en 
ligne*

ou

HP Integrity Essentials Global Workload Manager - 
Guide de mise en route 
(/opt/gwlm/doc/getting.started.with.gWLM.pdf**)

En savoir plus sur les concepts liés à 
gWLM

Rubrique Global Workload Manager dans l'aide en 
ligne*

ou

HP Integrity Essentials Global Workload Manager - 
Guide de mise en route 
(/opt/gwlm/doc/getting.started.with.gWLM.pdf**)

En savoir plus sur les termes liés à 
gWLM

Glossaire dans l'aide en ligne*
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En savoir plus sur les pratiques 
recommandées concernant gWLM

Rubrique "Getting the most out of gWLM" dans 
l'aide en ligne

En savoir plus sur d'autres 
fonctionnalités de gWLM

HP Integrity Essentials Global Workload Manager - 
Guide de l'administrateur (ce document)
(/opt/gwlm/doc/gWLM.admin.guide.pdf**)

En savoir plus sur l'interface gWLM 
dans HP Systems Insight Manager

Aide en ligne*

En savoir plus sur l'interface de 
ligne de commande de gWLM

Page de manuel gwlm(1M)

En savoir plus sur les démons 
gWLM

Page de manuel gwlmcmsd(1M)

En savoir plus sur l'utilisation de 
communications sécurisées avec 
gWLM

Page de manuel gwlmsslconfig(1M)

En savoir plus sur la façon de 
mettre à jour des métriques lors de 
l'utilisation de stratégies 
personnalisées

Page de manuel gwlmsend(1M)

En savoir plus sur la façon de placer 
manuellement des processus dans 
des charges de travail basées sur 
des psets ou des groupes fss

Page de manuel gwlmplace(1M)

En savoir plus sur l'utilisation de 
gWLM avec Serviceguard

Le site Web de documentation technique pour 
HP Virtual Server Environment (VSE) :

http://docs.hp.com

En savoir plus sur les npars, les 
vpars, les machines virtuelles et les 
psets

• Site Web HP Virtual Server Environment :

http://www.hp.com/go/vse

• Le site Web de documentation technique pour 
HP Virtual Server Environment (VSE) :

http://docs.hp.com

Tableau 1-2 Où trouver des informations complémentaires (suite)

Pour... Reportez-vous à...
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* Pour accéder à l'aide en ligne dans SIM, sélectionnez Tools -> VSE 
Management, suivi de l'onglet Shared Resource Domain, puis du point 
d'interrogation [?] dans le coin supérieur droit.

** La documentation dans /opt/gwlm/doc/ est en anglais uniquement. 
Pour obtenir la documentation dans d'autres langues, reportez-vous au 
site Web http://docs.hp.com.
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